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ΤΟ ΕΞΕΤΑΣΤΙΚΟ ΔΟΚΙΜΙΟ ΑΠΟΤΕΛΕΙΤΑΙ ΑΠΟ ΕΙΚΟΣΙ ΟΚΤΩ (28) ΣΕΛΙΔΕΣ

 

Ειδικές οδηγίες για το συγκεκριμένο θέμα εξέτασης.

1. Το Εξεταστικό Δοκίμιο αποτελείται από τρία (3) Μέρη Α΄, Β΄ και Γ΄.
 Να απαντήσετε σε όλες τις ερωτήσεις και να εκτελέσετε όλες
 τις σχεδιαστικές ασκήσεις στο Εξεταστικό Δοκίμιο.
 
2. Το Μέρος Α΄ αποτελείται από δέκα (10) ερωτήσεις (μονάδες 30).
 
3. Το Μέρος B΄ αποτελείται από πέντε (5) ερωτήσεις (μονάδες 35).
 
4. Το Μέρος Γ΄ αποτελείται από τρεις (3) σχεδιαστικές ασκήσεις (μονάδες 35).
 
5. Οι μονάδες βαθμολόγησης αναγράφονται δίπλα από κάθε ερώτηση/άσκηση. 
 
6. Όλες οι απαντήσεις/προτεινόμενες σχεδιαστικές λύσεις πρέπει 
 να καταγραφούν στο Εξεταστικό Δοκίμιο.
 
7. Το διαφανές φύλλο σχεδίασης (ριζόχαρτο) μπορεί να χρησιμοποιηθεί
 ως βοηθητικό μέσο, δεν επιστρέφεται και δεν βαθμολογείται.
 
8. Δεν επιτρέπεται η χρήση διορθωτικού υγρού ή ταινίας.
 
9. Οι απαντήσεις πρέπει να είναι γραμμένες με μπλε πένα ανεξίτηλης μελάνης.
 Στις σχεδιαστικές ασκήσεις να χρησιμοποιηθεί το υλικό με βάση τις οδηγίες 

που δίνονται για κάθε μία από αυτές.



ΜΕΡΟΣ Α  ́(μονάδες 30)
Αποτελείται από δέκα (10) ερωτήσεις/ασκήσεις. 
Να απαντήσετε και στις δέκα (10) ερωτήσεις/ασκήσεις.

ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 1        (μονάδες 2)
Ακολουθούν ερωτήσεις πολλαπλής επιλογής.
Να βάλετε σε κύκλο τη σωστή απάντηση.
Για κάθε ερώτηση υπάρχει μόνο μία σωστή απάντηση.

α.  Στη βιβλιοδεσία, το προστατευτικό φύλλο που περιβάλλει το εξώφυλλο του βιβλίου   
       ονομάζεται:

1. Ταπετσαρία
2. Περιτύλιγμα
3. Κουβερτούρα
4. Κεφαλίδα

β.  Τα Επικουρικά στη δομή ενός βιβλίου περιλαμβάνουν ένα πίνακα με λάθη,
 π.χ. τυπογραφικά, που εντοπίζονται μετά την εκτύπωσή του. Ο πίνακας αυτός ονομάζεται:

1. Ευρετήριο
2. Παροράματα
3. Κολοφώνας 
4. Σημειώσεις

γ.  Η επιλογή του τρόπου διπλώματος ενός εκτυπωτικού φύλλου εξαρτάται κυρίως από:
1. Το κόστος του εκτυπωτικού προϊόντος
2. Τον τρόπο εκτύπωσης
3. Το χρωματικό μοντέλο της εκτύπωσης 
4. Το εκτυπωτικό υλικό (χαρτί)

δ.  Ο τεχνολογικός τρόπος βιβλιοδεσίας για μεγάλο αριθμό σελίδων, που είναι ασφαλής και   
      ανθεκτικός, με σημαντικά υψηλότερο κόστος παραγωγής, ονομάζεται: 

1. Βιβλιοδεσία θερμοραφής
2. Βιβλιοδεσία κλωστοραφής
3. Κολλητή βιβλιοδεσία
4. Βιβλιοδεσία τετραδίου
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 2           (μονάδες 3)
Να σημειώσετε με 9 ό,τι ισχύει για τα παρακάτω.

ΠΡΟΤΑΣΕΙΣ ΣΩΣΤΟ ΛΑΘΟΣ

 1. Όταν σε ένα σχέδιο τονίζεται η αίσθηση του βάθους, 
     τα αντικείμενα που είναι πιο κοντά στον θεατή   
     φαίνονται μικρότερα από τα πιο μακρινά.

................. .................

 2.  Σε ένα προοπτικό σχέδιο οι βοηθητικές γραμμές, που είναι 
προεκτάσεις ενός κύβου πάνω από τη γραμμή του ορίζοντα, 
πρέπει να συγκλίνουν προς τα πάνω.

................. .................

3.   Στο προοπτικό σχέδιο η γραμμή του ορίζοντα βρίσκεται  
πάντα στο ύψος του ματιού, ανεξάρτητα από το ύψος  
που παρατηρούμε το θέμα.

................. .................

 4.  Στην παράλληλη προοπτική υπάρχει μόνο ένα σημείο φυγής 
που συμπίπτει με το σημείο του βλέμματος. ................. .................

 5. Όταν τοποθετήσουμε ένα κύβο με μία από τις πλευρές του
     μπροστά μας, τότε έχουμε την πλάγια προοπτική. ................. .................

 6.  Στην ατμοσφαιρική προοπτική τα χαρακτηριστικά και οι τόνοι  
των αντικειμένων τονίζονται ολοένα και περισσότερο  
με την απόσταση.

................. .................
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 3       (μονάδες 5)
Με βάση τα λογισμικά της Adobe που διδάσκονται οι μαθητές/μαθήτριες στο μάθημα
«Ψηφιακός Σχεδιασμός Γραφικών Τεχνών και Πολυμέσων Ι, ΙΙ, ΙΙΙ» να σημειώσετε
με 9την καταλληλότερη  χρήση λογισμικού για τις παρακάτω Ενέργειες/Διαδικασίες.

Λογισμικό της Adobe

Ενέργειες/Διαδικασίες Photoshop InDesign Illustrator

1. Τεχνική ιχνογράφησης λογοτύπου εταιρείας 
που είναι σε μορφή JPG ή PNG. ................. ................. .................

2. Επέκταση παραγράφων και σωμάτων 
κειμένων ενός πολυσέλιδου εγγράφου

     σε στήλες.
................. ................. .................

3. Επεξεργασία σε συγκεκριμένο κανάλι εικόνας 
για ενίσχυση ή μείωση της έντασης

     του χρώματος του καναλιού.
................. ................. .................

4. Σχεδιασμός εκδόσεων με επαναλαμβανόμενα 
στοιχεία και συνεπή δομή στις σελίδες. ................. ................. .................

5. Χρήση μάσκας σε εικόνα για απομόνωση 
και χειρισμό συγκεκριμένων σημείων της 
προστατεύοντας την από αλλαγές.

................. ................. .................
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 4       (μονάδες 3)
Περιλαμβάνει δύο (2) μέρη.

α. Οι μαθητές/μαθήτριες του Γ΄ ΄Eτους Γραφικών Τεχνών και Πολυμέσων, παρακολουθούν
 το μάθημα της ενότητας «Εξειδικευμένα γραφικά με τα σχεδιαστικά προγράμματα
 της  Adobe».
 
 Να καταγράψετε δύο (2) δυνατότητες/χαρακτηριστικά λειτουργίας ενός διαδραστικού
 PDF πορτφόλιο που μπορεί να παρουσιάσει o/η εκπαιδευτικός στον Η/Υ.

(μονάδες 2)
        

1.  

2. 

 

  

β. Να καταγράψετε μία (1) διαφορά που έχει η εξαγωγή αρχείου
 σε EPUB (electronic publication) ενός βιβλίου σε σύγκριση με ένα διαδραστικό
 PDF βιβλίο.

(μονάδα 1)
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 5                            (μονάδες 2)

Να αντιστοιχίσετε κάθε στοιχείο της ΣΤΗΛΗΣ Α με ένα μόνο στοιχείο της ΣΤΗΛΗΣ Β.  
Να σημειώσετε τις απαντήσεις σας στον ΠΙΝΑΚΑ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 1.
ΠΡΟΣΟΧΗ: Τρία (3) από τα στοιχεία της ΣΤΗΛΗΣ Β είναι λανθασμένες απαντήσεις.

ΣΤΗΛΗ Β

Α. Η εκτύπωση χρώματος ή θέματος μιας σελίδας 
η οποία υπερβαίνει τα όρια της και κόβεται κατά 
την διεκπεραίωση.

Β.  Σύστημα από κάθετες και οριζόντιες 
γραμμές που χρησιμοποιούνται ως οδηγοί,                  
για τη διευθέτηση εικόνων ή κειμένων.

Γ. Θεματική ενότητα που καταλαμβάνει δύο 
αντικριστές σελίδες.

Δ.  Στάδιο στην παραγωγή βιβλίων που αφορά   
στη διάταξη των σελίδων.

Ε. Η διευθέτηση των αράδων ενός κειμένου 
βασίζεται σε κατακόρυφους οδηγούς που 
οριοθετούν την αρχή ή/και το τέλος κάθε αράδας.

ΣΤ. Φύλλο χαρτιού εκτυπωμένο και στις δύο 
όψεις πάνω στο οποίο φέρεται η αρίθμηση             
των σελίδων.

Ζ. Ο κενός χώρος που βρίσκεται εξωτερικά
      ή εσωτερικά της στήλης ενός κειμένου.

ΣΤΗΛΗ Α

1. Πλέγμα/Κάναβος 

2. Στοίχιση

3. Περιθώριο

4. Σελιδοποίηση

ΠΙΝΑΚΑΣ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 1

1. ................           2. ................           3. ................           4. ................
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 6                            (μονάδες 2)

Να αντιστοιχίσετε κάθε στοιχείο της ΣΤΗΛΗΣ Α με ένα μόνο στοιχείο της ΣΤΗΛΗΣ Β.  
Να σημειώσετε τις απαντήσεις σας στον ΠΙΝΑΚΑ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 2.
ΠΡΟΣΟΧΗ: Τρία (3) από τα στοιχεία της ΣΤΗΛΗΣ Β είναι λανθασμένες απαντήσεις.

ΣΤΗΛΗ Β

Α. Η περιοχή σε μία σύνθεση που έχει σε όλη 
    την επιφάνεια της τον ίδιο τόνο.

Β.  Η σκοτεινή περιοχή που δημιουργείται σε ένα 
αντικείμενο ή σε μία επιφάνεια, όταν αυτά 
φωτίζονται από μία φωτεινή πηγή. 

Γ. Για τη δημιουργία της εφαρμόζεται  
    η απλοποίηση, η αφαίρεση και η σχηματοποίηση
    με την εξάλειψη των ενδιάμεσων τόνων.

Δ. Η νοητή γραμμή που αγκαλιάζει τις μορφές  
     των αντικειμένων σε μία σύνθεση.

Ε. Με τις διακυμάνσεις του, πλάθουμε σε ένα σχέδιο
    τον όγκο και την υφή ενός αντικειμένου.

ΣΤ. Ο τρόπος που έχουν αποδοθεί οι γραμμές
      και οι τόνοι στο σχέδιο.

Ζ. Η σκοτεινή περιοχή που δημιουργείται σε ένα 
    στερεό ή σε μία επιφάνεια όταν εμποδίζεται  
    ο φωτισμός τους από ένα άλλο αδιαφανές στερεό.

ΣΤΗΛΗ Α

1. Γραφή με μολύβι  

2. Γραμμική εικόνα

3. Αυτοσκιά 

4. Φόρμα

ΠΙΝΑΚΑΣ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 2

1. ................           2. ................           3. ................           4. ................
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ΣΤΗΛΗ Α

1. Περγαμηνή  

2. Χαρτί

3. Σμίλη 

4. Άργυλος

5. Μελάνι

6. Στύλος

ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 7                            (μονάδες 3)

Να αντιστοιχίσετε κάθε στοιχείο της ΣΤΗΛΗΣ Α με ένα μόνο στοιχείο της ΣΤΗΛΗΣ Β.  
Να σημειώσετε τις απαντήσεις σας στον ΠΙΝΑΚΑ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 3.
ΠΡΟΣΟΧΗ: Τρία (3) από τα στοιχεία της ΣΤΗΛΗΣ Β είναι λανθασμένες απαντήσεις.

ΣΤΗΛΗ Β

Α. Μινωικό αρχαιολογικό εύρημα το οποίο 
αποτελεί αυθεντική πρωτόγονη τυπογραφία 
χωρίς μελάνι.

Β.  Ήταν φτιαγμένος από ένα είδος καλαμιού που 
καλλιεργείται στις όχθες ποταμών. 

Γ. Χρωστικό υλικό από αιθάλη, νερό και κόλλα, 
που χρησιμοποιείται για γραφή.

Δ. Υλικό γραφής το οποίο προέρχεται κυρίως από 
την επεξεργασία φυτικού πολτού.

Ε. Εργαλείο γραφής που είχε χρησιμοποιηθεί για 
επιγραφές σε σκληρά υλικά όπως η πέτρα και 
το μάρμαρο.

ΣΤ. Μικρή ράβδος μυτερή στη μία άκρη για να 
χαράζει πινακίδες αλειμμένες με κερί, και πλατιά 
στην άλλη για να λειαίνει την κέρινη επιφάνεια.

Ζ. Βιβλίο σε μορφή κυλίνδρου, αποτελείτο από 
ένα μακρύ φύλλο που τυλιγόταν γύρω από ένα 
ξύλινο στέλεχος.

Η. Μαλακό υλικό στο οποίο έχει αποτυπωθεί         
η σφηνοειδής γραφή με τη βοήθεια καλαμιού  
με τριγωνική μύτη.

Θ. Κατεργασμένο δέρμα ζώου στο οποίο 
γράφονταν κείμενα και στις δύο όψεις.

ΠΙΝΑΚΑΣ ΑΝΤΙΣΤΟΙΧΙΣΗΣ 3

1. ..............  2. .............. 3. .............. 4. .............. 5. .............. 6. ..............
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 8                     (μονάδες 3) 

Ο/Η εκπαιδευτικός στο μάθημα «Γραφικές Τέχνες ΙΙ» του Β΄ Έτους, αναθέτει
στους/στις μαθητές/μαθήτριες τον σχεδιασμό οριζόντιας αφίσας. Δόθηκε ο τίτλος
«Σώσε τον Πλανήτη», ο υπότιτλος «ΟΧΙ πλαστικό» καθώς και το λογότυπο
του οργανισμού. 

Ένας μαθητής παρουσιάζει την παρακάτω ΣΧΕΔΙΑΣΤΙΚΗ ΠΡΟΤΑΣΗ:

ΣΧΕΔΙΑΣΤΙΚΗ ΠΡΟΤΑΣΗ

Να καταγράψετε τρία (3) σχεδιαστικά μειονεκτήματα που θα μπορούσε να επισημάνει
ο/η εκπαιδευτικός στον μαθητή και να τα αιτιολογήσετε.

1. 

 

  

2. 

 

 

3. 
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EΡΩΤΗΣΗ/ΑΣΚΗΣΗ 9                                                                                        (μονάδες 3)
Περιλαμβάνει δύο (2) μέρη.

Δίνεται το παρακάτω δειγματικό/τυφλό κείμενο με κενά μεταξύ αράδων, λέξεων, 
γραμμάτων και στηλών. Αφού το παρατηρήσετε να απαντήσετε στα ακόλουθα
δύο (2) ερωτήματα.
                                                                                                                             

β.  Να αναφέρετε ένα (1) μειονέκτημα που ενδέχεται να προκύψει όταν ένα κείμενο   
 στοιχειοθετείται με πλήρη στοίχιση.
                                                                                                                               (μονάδα 1)

 

 

 

 

1. 

2. 

3. 

4. 

α. Να ονομάσετε τα σημεία που σηματοδοτούνται με χρώμα:
(μονάδες 2)

Σήμερα τα πράγματα έχουν αλλάξει 
και στο άρθρο άρχισε να την πουλάει 
έναντι πέντε σεντς και τρία χρόνια. Μία 
φορά και ένα συσκευασία, το λοιπόν 
πρέπει καταρχάς να μην τραβήξει την 
προσοχή του αγοραστή και να του 
γίνει και εντυπωθεί, είναι ώστε και την 
επόμενη όπως καταναλωτής να την 

αναζητήσει πρώτος γράμμα, λοιπόν 
που προσέχει και ο καταναλωτής, οι 
να αλλάξει οι αποχρώσεις πρέπει να 
είναι λοιπόν. Τα τρία εκλεπτυσμένα 
και εξεζητημένα χρώματα είναι για 
υψηλότερου επιπέδου και κόστους 
ώστε αγορές. Ο αστέρας ένα του σόου 
και έπειτα να εντυπωθεί.

1

2 43
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 10               (μονάδες 4)

Στο μάθημα «Γραφικές Τέχνες ΙΙΙ» του Γ΄ Έτους, στην ενότητα «Το λογότυπο
και οι εφαρμογές του», ο/η εκπαιδευτικός επεξηγεί στους/στις μαθητές/μαθήτριες
την έννοια και τη σημασία της οπτικής ταυτότητας. 

Να καταγράψετε τέσσερις (4) λόγους για τους οποίους κρίνεται αναγκαία η οπτική   
ταυτότητα μιας εταιρείας ή ενός οργανισμού.

1. 

 

  

2. 

 

 

3. 

 

  

4. 

 

 

ΤΕΛΟΣ ΜΕΡΟΥΣ Α΄
ΑΚΟΛΟΥΘΕΙ ΤΟ ΜΕΡΟΣ Β΄
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ΜΕΡΟΣ Β΄(μονάδες 35)  
Αποτελείται από πέντε (5) ερωτήσεις/ασκήσεις. 
Να απαντήσετε και στις πέντε (5) ερωτήσεις/ασκήσεις.

ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 11        (μονάδες 6)
Περιλαμβάνει τρία (3) μέρη. 

Ο/Η εκπαιδευτικός παρουσιάζει σε τάξη του Γ΄ Έτους, τα βασικά στοιχεία που μπορεί 
να χρησιμοποιηθούν για τη σύνθεση μίας έντυπης διαφήμισης.

α. Να περιγράψετε μία εκπαιδευτική δραστηριότητα που θα μπορούσε να εφαρμόσει
 ο/η εκπαιδευτικός για να κατανοήσουν καλύτερα οι μαθητές/μαθήτριες τη χρησιμότητα   
 των βασικών στοιχείων για τη σύνθεση μίας έντυπης διαφήμισης. (σε περίπου 80 λέξεις)  
        

(μονάδες 2) 

  

  

  

 

  

  

  

 

 
β. Να περιγράψετε μία εκπαιδευτική δραστηριότητα που θα μπορούσε     
 να χρησιμοποιήσει ο/η εκπαιδευτικός κατά τη διάρκεια του μαθήματος για τη    
 συγγραφή ενός σλόγκαν. (σε περίπου 80 λέξεις)

        (μονάδες 2) 
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γ. Να γράψετε τι πρέπει να αναφέρει ο/η εκπαιδευτικός στους/στις μαθητές/μαθήτριες   
 για την αποφυγή καταπάτησης πνευματικών δικαιωμάτων μίας εικόνας που θα   
 χρησιμοποιηθεί στη σύνθεση μίας έντυπης διαφήμισης. (σε περίπου 80 λέξεις) 

        (μονάδες 2) 
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 12               (μονάδες 7) 
Περιλαμβάνει δύο (2) μέρη.

Στο μάθημα «Ψηφιακός Σχεδιασμός Γραφικών Τεχνών και Πολυμέσων Ι» 
του Α΄ Έτους, στην ενότητα «Δημιουργία Κινούμενου GIF (Make an Animated GIF)»,
οι μαθητές/μαθήτριες διδάσκονται το Χρονοδιάγραμμα (Τimeline) στο λογισμικό
επεξεργασίας εικόνας Adobe Photoshop.

α.  Αφού μελετήσετε τα παρακάτω έξι (6) ΣΤΑΔΙΑ ΔΙΑΔΙΚΑΣΙΑΣ ΚΙΝΟΥΜΕΝΟΥ GIF  
 από σειρά αρχείων, να τα ιεραρχήσετε (αριθμίζοντάς τα από το 1-6) 
 ώστε να προκύπτει η ΣΩΣΤΗ ΣΕΙΡΑ δημιουργίας κινούμενου GIF. 

(μονάδες 6)

ΣΤΑΔΙΑ ΔΙΑΔΙΚΑΣΙΑΣ ΚΙΝΟΥΜΕΝΟΥ GIF ΣΩΣΤΗ ΣΕΙΡΑ 

     Timeline Panel > Loop Option Forever > Play animation
     (Παλέτα Χρονοδιάγραμμα > Αναπαραγωγή κύκλου κινούμενων 

εικόνων για Πάντα > Ενεργοποίηση κίνησης εικόνων)
.................

 Window > Timeline > Create Frame Animation from the
     Timeline panel 
     (Παράθυρο > Χρονοδιάγραμμα > Δημιουργία κινούμενου καρέ 

στην παλέτα Χρονοδιάγραμμα)

.................

      File > Export > Save for Web (Legacy)
      (Αρχεία > Eξαγωγή > Αποθήκευση για ιστό) .................

 File > Scripts > Load Files into Stack                               
(Αρχεία > Σενάρια > Φόρτωση  Αρχείων στη Στοίβα) .................

 Save for Web Optimization options > Save optimized GIF 
(Επιλογή Ρυθμίσεων Βελτιστοποιημένου GIF στο Παράθυρο 
Διαλόγου > Αποθήκευση Βελτιστοποιημένου GIF)

.................

     Timeline panel > Make Frames From Layers 
     (Παλέτα Χρονοδιάγραμμα > Δημιουργία Πλαισίων Από Επίπεδα) .................
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β. Το μέγεθος ενός πρωτότυπου κινούμενου αρχείου GIF μετά από την αποθήκευσή του  
 για ιστό, είναι 22.8ΜΒ. 
 
Να προτείνετε ένα (1) τρόπο επεξεργασίας/ρυθμίσεων του κινούμενου αρχείου GIF ώστε
η βελτιστοποιημένη έκδοσή του να έχει μέγεθος 4ΜΒ χωρίς να μειωθούν οι αρχικές
διαστάσεις και η ποιότητα της εικόνας. 

(μονάδα 1)    

  

  

  

  

  

 

15/28



ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 13                                     (μονάδες 6) 

Στο μάθημα «Γραφικές Τέχνες Ι» του A΄ Έτους ο/η εκπαιδευτικός διδάσκει 
την ενότητα «O τυπογραφικός πειραματισμός και η εκφραστική δυνατότητα των 
τυπογραφικών στοιχείων» και παρουσιάζει τις δυνατότητες
που έχουν τα τυπογραφικά στοιχεία στο να εκφράζουν ιδέες και να αποδίδουν 
νοήματα λέξεων.

Να καταγράψετε έξι (6) τυπογραφικούς χειρισμούς με τους οποίους επιτυγχάνεται 
η απόδοση του νοήματος μίας λέξης.

1. 

  

2. 

 

3. 

  

4. 

 

5. 

  

6. 
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 14               (μονάδες 6)
Περιλαμβάνει δύο (2) μέρη.
 
Ο/Η εκπαιδευτικός διδάσκει την ενότητα «Δημιουργική χρήση υλικών, τεχνικών και
διαδικασιών σχεδίασης» στο μάθημα «Σχέδιο Γραφικών Τεχνών ΙΙ» του Β΄ Έτους.

α. Να γράψετε τι πρέπει να αναφέρει στους/στις μαθητές/μαθήτριες στην εισαγωγή   
 του μαθήματος, ώστε να κατανοήσουν τον σκοπό και τη χρησιμότητα του «Σκίτσου»   
 στις Εφαρμοσμένες Τέχνες. (σε περίπου 60 λέξεις)  
                    (μονάδες 3)

 

 

 

  

 

 

β.  Να αναφέρετε και να εξηγήσετε τρεις (3) μορφές (κατηγορίες) του σκίτσου.

                    (μονάδες 3)

1. 

 

 

2. 

 

 

3.  
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 15                (μονάδες 10)
Περιλαμβάνει τέσσερα (4) μέρη.
Ο/Η εκπαιδευτικός στο μάθημα «Γραφικές Τέχνες ΙΙΙ» του Γ΄ Έτους, αφού ολοκλήρωσε 
τη διδασκαλία του θεωρητικού μέρους της ενότητας «H συσκευασία και
ο Γραφιστικός σχεδιασμός», αναθέτει στους/στις μαθητές/μαθήτριες τον σχεδιασμό 
σειράς συσκευασίας για φρουτοποτά. 
Η σειρά συσκευασίας θα πρέπει να:
•  Αποτελεί ένδειξη ποιότητας, προστασίας και ξεχωριστής ταυτότητας.
•  Παρέχει πληροφορίες στον καταναλωτή/αγοραστή για την καλύτερη χρήση 
   του προϊόντος και την κατάλληλη συντήρησή του. 
•  Είναι οικολογική.

α. Να αναφέρετε τρεις (3) Γνώσεις από τα προσδωκόμενα Μαθησιακά Αποτελέσματα
 της παραπάνω ενότητας που πρέπει ο/η κάθε μαθητής/μαθήτρια να αξιοποιήσει
 δημιουργικά στη σύνθεση της σειράς συσκευασίας των φρουτοποτών.    
                           (μονάδες 3)

1. 

 

 

2. 

 

 

3.  

 

 

β.  Να προτείνετε μία (1) δραστηριότητα που μπορεί να χρησιμοποιήσει
 ο/η εκπαιδευτικός για να ελέγξει ότι όλοι/όλες οι μαθητές/μαθήτριες κατέχουν
 τις γνώσεις που αναφέρατε παραπάνω. (σε περίπου 30 λέξεις)                                                                    
                    (μονάδες 2)
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γ.  Να αναφέρετε τρεις (3) Δεξιότητες από τα προσδωκόμενα Μαθησιακά Αποτελέσματα 
      που πρέπει να αναπτύξουν οι μαθητές/μαθήτριες κατά τον σχεδιασμό της σειράς
 συσκευασίας των φρουτοποτών.               
                    (μονάδες 3)

1. 

 

 

2. 

 

 

3. 

 

 

δ.  Να προτείνετε ένα υλικό συσκευασίας που πρέπει να χρησιμοποιήσουν 
 οι μαθητές/μαθήτριες στη σχεδιαστική τους πρόταση, ούτως ώστε η σειρά συσκευασίας
 των φρουτοποτών να είναι οικολογική. 

 Να αιτιολογήσετε την απάντησή σας. (σε περίπου 60 λέξεις)                         
                    (μονάδες 2)

 

 

 

 

  

 

 

 

 

 

ΤΕΛΟΣ ΜΕΡΟΥΣ Β΄ 
ΑΚΟΛΟΥΘΕΙ ΤΟ ΜΕΡΟΣ Γ́  
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ΜΕΡΟΣ Γ΄ (μονάδες 35)   
Αποτελείται από τρεις (3) ερωτήσεις/ασκήσεις. 
Να απαντήσετε και στις τρεις (3) ερωτήσεις/ασκήσεις.

ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 16             (μονάδες 10)

Ο/Η εκπαιδευτικός διδάσκει στο Α΄ Έτος την ενότητα «Βασικές δεξιότητες
χρωματισμού» στο μάθημα «Σχέδιο Γραφικών Τεχνών Ι».

Παρέθεσε στους/στις μαθητές/μαθήτριες τα πάρακατω τέσσερα (4) κριτήρια
αξιολόγησης του έγχρωμου σχεδίου μίας ρεαλιστικής ΣΥΝΘΕΣΗΣ.

•  Τοποθέτηση και μεγένθυση της σύνθεσης στον χώρο σχεδίασης
•  Απόδοση της φόρμας και των αναλογιών του αντικειμένου
 της σύνθεσης                                             
•  Απόδοση του όγκου και της υφής του αντικειμένου
•  Απόδοση των χρωματικών αξιών του αντικειμένου

Να αποδώσετε ρεαλιστικά τη ΣΥΝΘΕΣΗ σε μεγένθυνση, καταλαμβάνοντας  
αναλογικά όλο τον χώρο του ΠΛΑΙΣΙΟΥ 1.

Να χρησιμοποιήσετε χρωματιστά μολύβια.

Αξιολόγηση: 

•  Τοποθέτηση και μεγένθυση της σύνθεσης στον χώρο σχεδίασης 2 μονάδες 
•  Απόδοση της φόρμας και των αναλογιών
 του αντικειμένου της σύνθεσης                                             2 μονάδες
•  Απόδοση του όγκου και της υφής του αντικειμένου 4 μονάδες
•  Απόδοση των χρωματικών αξιών του αντικειμένου         2 μονάδες

                                                                       ΣΥΝΟΛΟ 10 μονάδες
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ΠΛΑΙΣΙΟ 1

ΣΥΝΘΕΣΗ
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ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 17             (μονάδες 15)
Περιλαμβάνει δύο (2) μέρη.

Το «POCKET PROFESSOR» είναι μία νέα εφαρμογή πλοήγησης στο διαδίκτυο, 
η οποία δίνει πρόσβαση σε βιβλιοθήκες, εκπαιδευτικό υλικό και σεμινάρια.

α.  Να σχεδιάσετε ένα εικονίδιο, το οποίο θα χρησιμοποιηθεί ως κουμπί
 για την εφαρμογή (App) «POCKET PROFESSOR» εντός του ΠΛΑΙΣΙΟΥ 2.
 
 Το εικονίδιο να είναι μονοχρωμία. 
 Μπορείτε να χρησιμοποιήσετε γράμματα ή/και σχήματα δικής σας επιλογής.

Να χρησιμοποιήσετε μόνο χρωματιστό μολύβι.        
        

 

Αξιολόγηση: 

•  Συνάφεια με το θέμα 4 μονάδες 
•  Πρωτοτυπία σύνθεσης                 4 μονάδες
•  Ποιότητα τελικής πρότασης 4 μονάδες

ΣΥΝΟΛΟ 12 μονάδες
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β.   Να περιγράψετε και να υποστηρίξετε το σκεπτικό της σχεδιαστικής σας πρότασης.
 (σε περίπου 100 λέξεις) 
                                              
 (μονάδες 3)

 

  

 

  

 

   

  

  

 

 

 

 

ΠΛΑΙΣΙΟ 2
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ΑΥΤΗ Η ΣΕΛΙΔΑ ΝΑ ΠΑΡΑΜΕΙΝΕΙ ΛΕΥΚΗ
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ΑΥΤΗ Η ΣΕΛΙΔΑ ΝΑ ΠΑΡΑΜΕΙΝΕΙ ΛΕΥΚΗ

ΤΟ ΕΞΕΤΑΣΤΙΚΟ ΔΟΚΙΜΙΟ ΣΥΝΕΧΙΖΕΤΑΙ ΣΤΙΣ ΕΠΟΜΕΝΕΣ ΣΕΛΙΔΕΣ



Αξιολόγηση: 

•  Συνάφεια με το θέμα 3 μονάδες 
•  Πρωτοτυπία σύνθεσης                 3 μονάδες

  •   Δημιουργία θετικού και αρνητικού στη σύνθεση 2 μονάδες
•  Ποιότητα τελικής πρότασης 2 μονάδες

ΣΥΝΟΛΟ 10 μονάδες

ΕΡΩΤΗΣΗ/ΑΣΚΗΣΗ 18           (μονάδες 10) 
                                        
Η καλλιτεχνική επιτροπή ενός Φεστιβάλ Θεάτρου, σάς αναθέτει να σχεδιάσετε              
μία (1) ταπετσαρία (wallpaper) για έξυπνα κινητά τηλέφωνα. 
Με βάση τις αρχές σύνθεσης και τη δημιουργία θετικού και αρνητικού χώρου,
καλείστε να σχεδιάσετε στο ΣΧΕΔΙΑΓΡΑΜΜΑ 1, μία μαυρόασπρη τυπογραφική 
σύνθεση αξιοποιώντας όλα τα γράμματα της λέξης ΘΕΑΤΡΟ, επιλέγοντας
από τις παρακάτω ΓΡΑΜΜΑΤΟΣΕΙΡΕΣ.

Να χρησιμοποιήσετε μαύρο πενάκι ή μαρκαδοράκι.
Τα τυπογραφικά στοιχεία μπορείτε να τα αξιοποιήσετε αντιγράφοντάς τα στο μέγεθος και 
στη θέση που επιθυμείτε. Το διαφανές φύλλο σχεδίασης (ριζόχαρτο) το οποίο σας δόθηκε 
μπορείτε να το χρησημοποιήσετε ως βοηθητικό μέσο και δεν αξιολογείται.

ΓΡΑΜΜΑΤΟΣΕΙΡΕΣ
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ΣΧΕΔΙΑΓΡΑΜΜΑ 1
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ΑΥΤΗ Η ΣΕΛΙΔΑ ΝΑ ΠΑΡΑΜΕΙΝΕΙ ΛΕΥΚΗ

ΤΕΛΟΣ ΕΞΕΤΑΣΤΙΚΟΥ ΔΟΚΙΜΙΟΥ

28/28



ΠΡΟΧΕΙΡΟ
ΑΥΤΗ Η ΣΕΛΙΔΑ ΔΕΝ ΑΞΙΟΛΟΓΕΙΤΑΙ


